Table of Contents

Table of Contents ................................................................. 1

Audio interface and control surface ........................................ 2

R16 audio interface system environment ...................................... 4
Connecting and disconnecting in audio interface mode ...................... 5

Control surface functions
Using the control surface functions .......................................... 7
Fader section operation .......................................................... 9
Setting up function keys ......................................................... 11

Control Surface Functions Quick Reference Sheet .......................... 12

The mixer in audio interface mode
Volume, reverb send and pan .................................................... 13
Stereo Link ............................................................................ 13
DIRECT/DAW BALANCE ............................................................. 13
Tuner .................................................................................... 14

Effects in audio interface mode
Insert effect ............................................................................. 15
Send return effect (reverb) ....................................................... 15

Working with patches
Patch operations ................................................................. 16
Patch initialization (factory reset) ............................................. 16
Audio interface and control surface

This section explains how to set up and use the functions of the R16 audio interface and control surface with DAW software installed on your computer.

Functions of the audio interface and control surface

Audio interface

The various input and output jacks of the R16 can be used as a Hi-Speed USB (USB 2.0) audio interface with support for 8 ins and 2 outs and input and output quality up to 24-bit/96kHz. Effects can also be used when the sampling rate is 44.1 kHz, and the unit can be powered by the computer's USB bus.

Control surface functions

The on-board control surface functions can be used to control DAW software on your computer via USB. Transport operations, including playback, recording and stopping, and physical control of the DAW faders are possible. Furthermore, various other DAW software functions can be mapped to the F1–F5 keys. (The available functions depend on the DAW software used.)
In addition to standard chromatic tuning, the multifunction tuner also has on-board support for 7-string guitar, 5-string bass and various drop tunings.

Comprehensive built-in mixer
Using the R16’s mixer, you can make a mix for monitoring live and playback. When simultaneously recording guitar and vocals, for example, you can independently adjust volume balance, panning and reverb levels.

Versatile effect functions
The insert effect can be applied to specific channel paths and the send/return effect works via the mixer send/return. The two kinds of built-in effects can be applied when recording, of course, but they can also be applied to affect only the monitoring output. For example, when recording vocals, you can apply reverb to the monitor signal to make singing easier, but record a dry signal.

Supports input from a variety of sources, including guitars, mics and line level instruments.
The 8 onboard jacks, which accept XLR and standard phone plugs, include one high-impedance input and two with 48V phantom power. From high-impedance guitars and basses to dynamic and condenser microphones and line-level devices like synthesizers, many sources are supported. In addition, the built-in high-performance condenser microphones are convenient for recording acoustic guitar and vocals.

Multifunction tuner
In addition to standard chromatic tuning, the multifunction tuner also has on-board support for 7-string guitar, 5-string bass and various drop tunings.
R16 audio interface system environment

To use DAW software with this unit, you need to install it and make settings in it for the R16. This is an explanation for doing so with Cubase LE.

R16 audio interface system requirements

Cubase LE installation guide

Please refer to the Cubase LE Startup Guide for detailed instructions for installing the R16 audio driver and Cubase LE.

**Windows**

Windows® 7 (32-bit, 64-bit) or later
32-bit: Intel® Pentium® 4 1.8 GHz or faster
64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster
32-bit: RAM 1 GB or faster
64-bit: RAM 2 GB or faster

**Intel Mac**

OS X 10.9 or later
Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

**Both**

USB 2.0 compatible port

* USB hubs are not supported.

**About the screen images**

The screen images are of the Windows version.

**About trademarks**

- The SD symbol and SDHC symbol are trademarks.
- Windows®, Windows 7® are trademarks or registered trademarks of Microsoft®.
- Macintosh®, and Mac OS® are trademarks or registered trademarks of Apple Inc.
- Steinberg and Cubase are trademarks or registered trademarks of Steinberg Media Technologies GmbH Inc.
- Intel® and Pentium® are trademarks or registered trademarks of Intel Corporation.
- MACKIE Control is a trademark or registered trademark of LOUD Technologies.
- All other trademarks, product names, and company names mentioned in this documentation are the property of their respective owners.
- All trademarks and registered trademarks mentioned in this manual are for identification purposes only and are not intended to infringe on the copyrighted properties of their respective owners.
Connecting and disconnecting in audio interface mode

This is a brief overview of connecting and disconnecting when a computer is hooked to the R16 by USB cable. For details, please refer to the separately attached “Cubase LE Startup Guide”.

**Connecting the R16 to the computer for the first time**

1. Install Cubase LE DAW software on the computer
2. Download the latest ZOOM R16 / R24 audio driver from the ZOOM website (see below).
3. Install the audio driver on the computer.
   - **Install/setup details**
     - Reference: “Cubase LE Startup Guide”
4. Connect the R16 to the computer.
   - **R16 setup and connection**
5. Setup DAW software
   - **Device setup**
   - Reference: “Cubase LE Startup Guide”
   - Control surface setup (Mackie Control) P.7

**NOTE**

The ZOOM R16/R24 audio driver is essential for using the R16 as an audio interface for DAW software such as Cubase LE.

When downloading, follow the included instruction guide to install correctly.

- Please download the latest R16 audio driver from Zoom Corporation’s website at (http://www.zoom.co.jp).

**NOTE**

- Set the recording quantization (bit depth) of Cubase LE or the DAW software that you are using to 24-bit in order to achieve the best audio quality when recording. (See the software manual for how to make this setting.)
Connect the USB cable to the R16.

The [DEVICE] USB indicator will light.

Connect the USB cable to the computer.

When connection is complete the AUDIO INTERFACE icon appears.

Disconnecting

1. Press [USB].

2. Terminate the connection.

3. Remove the USB cable.

NOTE

Data transferred with CONTINUE
- INSERT EFFECT settings
- SEND RETURN EFFECT settings
- Track parameter settings
- TUNER settings

RESET
Restores default settings for each item

- The audio interface and control surface functions of the R16 can be used by drawing power through the USB bus. Power from batteries or the adapter is not necessary.
- We recommend always using the latest R16 system software. Operating the R16 with an older system could result in it not being recognized by your computer.
Using the control surface functions

When using the R16 connected by USB as an audio interface, the R16 keys and faders can be used to control Cubase LE’s transport and mixer.

### About the control surface

In control surface mode the keys and knobs on the R16 can be assigned to particular Cubase LE functions.

### Control surface settings

- **See R16 setup and connection steps 1~6 on P.5~6.**

1. **Launch Cubase LE.**
2. Select “Device Setup” from the Cubase LE “Device” menu.
3. On the top left of the device setup window there are [+ ] [-] [<>] buttons. Click the [+ ] and then choose “Mackie Control.”
4. **Set MIDI input and output.**
   - MIDI Input: Zoom R16_R24
   - MIDI Output: Zoom R16_R24

### HINT

- **Assigning Keys**
  For a list of functions that can be assigned to the knobs and keys of the R16, as well as other transport/function keys that are supported by Cubase LE, please consult the “Control Surface Mode Functions Quick Reference Guide” of this manual.

- **HINT**
  The display of MENU etc. may be different depending on the version of Cubase LE. Please refer to your Cubase LE manual.
By setting up the control surface, the R16’s transport section keys can be assigned to individual functions in Cubase LE.
Fader section operation

By using the faders and status keys of the R16 fader section, you can control the volume and muting, pause recording and switch solo on and off in the corresponding Cubase LE tracks.

**About banks**

After setting up control surface operation, the main parameters of Cubase LE can be operated using the R16's fader and status keys.

A group of tracks operated by the faders and status keys is called a "bank," and one bank includes 8 tracks.

For example, if fader 1 is assigned to Cubase LE track 1, tracks 1-8 can be operated as shown in the following diagram.

<table>
<thead>
<tr>
<th>Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.1</td>
<td>Tr.2</td>
<td>Tr.3</td>
<td>Tr.4</td>
<td>Tr.5</td>
<td>Tr.6</td>
<td>Tr.7</td>
<td>Tr.8</td>
</tr>
</tbody>
</table>

As the diagram shows, pressing the [9~16Tr (Bank>)] key once switches the allocations as shown below.

<table>
<thead>
<tr>
<th>Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.9</td>
<td>Tr.10</td>
<td>Tr.11</td>
<td>Tr.12</td>
<td>Tr.13</td>
<td>Tr.14</td>
<td>Tr.15</td>
<td>Tr.16</td>
</tr>
</tbody>
</table>

1. Assign the desired Cubase LE tracks (channels) to the fader section.

2. Use the faders to control the volumes of the corresponding tracks.

The faders control the volumes of their respective tracks. Change the master volume by moving the [Master] Fader.

- **[1-8Tr] Key (< BANK)**
  Tracks (channels) assigned to the fader section are moved backward by eight tracks.

- **[9-16Tr] Key (BANK >)**
  Tracks (channels) assigned to the fader section are moved forward by eight tracks.
Press the MASTER track status key to cycle through the functions of the individual track status keys.

By pressing a track status key, you can toggle solo, mute and record enable on and off for the corresponding track.

Each level meter other than the MASTER displays the signal immediately before sending it to the computer.

The mastering level meter displays the returning signal from the computer.

Checking DAW recording levels

By setting “REC SIGNAL” to “WET” (signal with effect) or “DRY” (no effect), you can send signals to the computer with or without being processed by the R16’s insert effects.

The recording levels of the sent signals are displayed on the level meters. The signals shown on the mastering level meter and each level meter are different.

Please adjust the level meter so that it does not light the red clip indicator.
Setting up function keys

The five keys above the transport keys can be used as function keys (F1~F5) and assigned as you desire.

**Function key setup method**

1. Open the Device Setup Dialog Box in Cubase LE.

2. Select Mackie Control
   Commands can be assigned in the three columns displayed on the right side of the window.

3. From the (Button) column choose the function key [F1~F5] to be assigned a Cubase LE function.

4. Click on the “Category” column for that key.

5. Choose the type of Cubase LE function from the Category pop-up menu.

6. Click on the “Command” column and select the desired specific Cubase LE function from the pop-up menu.
   (The contents of this pop-up menu will be different depending on the category chosen.)

7. Press the “Apply” button.

**HINT**

The display of MENU etc. may be different depending on the version of Cubase LE. Please refer to your Cubase LE manual.
# Control surface functions quick reference guide

<table>
<thead>
<tr>
<th>Control Section</th>
<th>Control</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fader section</strong></td>
<td>Status Key</td>
<td>Toggles mute, record enable or solo on the track on/off.</td>
</tr>
<tr>
<td></td>
<td>[MASTER] Status Key</td>
<td>Switches the function of the status keys</td>
</tr>
<tr>
<td></td>
<td>Fader</td>
<td>Controls the volume of the corresponding track</td>
</tr>
<tr>
<td></td>
<td>[MASTER] Fader</td>
<td>Controls the master volume</td>
</tr>
<tr>
<td><strong>Transport section</strong></td>
<td>[Curser] Keys</td>
<td>Performs the same functions as the arrow keys on the computer</td>
</tr>
<tr>
<td></td>
<td>Dial</td>
<td>Moves the cursor position</td>
</tr>
<tr>
<td></td>
<td>[REW] Key</td>
<td>Rewind</td>
</tr>
<tr>
<td></td>
<td>[FF] Key</td>
<td>Fast forward</td>
</tr>
<tr>
<td></td>
<td>[STOP] Key</td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td>[PLAY] Key</td>
<td>Play</td>
</tr>
<tr>
<td></td>
<td>[REC] Key</td>
<td>Record</td>
</tr>
<tr>
<td></td>
<td>[AUTO PUNCH I/O] Key</td>
<td>Depends on the [F1] key setting</td>
</tr>
<tr>
<td></td>
<td>[A-B REPEAT] Key</td>
<td>Depends on the [F2] key setting</td>
</tr>
<tr>
<td></td>
<td>MARKER [&lt;&lt;] Key</td>
<td>Depends on the [F3] key setting</td>
</tr>
<tr>
<td></td>
<td>MARKER [&gt;&gt;] Key</td>
<td>Depends on the [F4] key setting</td>
</tr>
<tr>
<td></td>
<td>[MARK] Key</td>
<td>Depends on the [F5] key setting</td>
</tr>
<tr>
<td><strong>Control section</strong></td>
<td>[1-8Tr] Key</td>
<td>Moves one bank backward</td>
</tr>
<tr>
<td></td>
<td>[9-16Tr] Key</td>
<td>Moves one bank forward</td>
</tr>
</tbody>
</table>
The mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R16’s internal mixer. In addition, you can adjust the balance of the internal mixer and the sound from the computer.

**Volume, reverb send and pan**

You can be adjust the REVERB SEND, PAN, VOLUME and STEREO LINK settings as in recorder mode. Operation is the same as in recorder mode. (Reference: OPERATION MANUAL P:37)

**The PAN/EQ Menu**

**VOLUME**

You can set the volume levels for INPUT 1~8 between 0~127 (increments of 1). 100 is the default.

**SEND REVERB**

You can change the reverb send levels for INPUT 1~8 from 0~100 (increments of 1) with 0 as the default (same as in recorder mode).

Reverb only affects the monitored signal.

**PAN (BALANCE)**

You can change the pan for INPUT 1~8 between L100~R100 (increments of 2) with C (center) as the default (same as in recorder mode).

**STEREO LINK**

Link even and odd numbered INPUTS to handle them as a stereo pair.

On/Off with “Off” as the default. By setting up a stereo link, REVERB SEND, PAN and VOLUME track parameters can be applied to even and odd inputs simultaneously. The odd numbered fader will be active (same as in recorder mode). (Reference : OPERATION MANUAL P.20)

**NOTE**

The R16 REVERB SEND, PAN, VOLUME and STEREO LINK settings are all saved when you terminate audio interface mode and can be used again the next time by choosing [CONTINUE] when you relaunch audio interface mode.
Tuner

The R16’s tuner can be used in the same way as in recorder mode. For further details please consult the OPERATION MANUAL.

CHROMATIC TUNER
TOOL>TUNER>CHROMATIC

1  Press [TOOL].

2  Select >TUNER

Push [Enter].

3  Select tuner type.

4  Select the base pitch and tune the instrument.

HINT

- The default base pitch is 440 Hz.
- Tuners other than the chromatic tuner can be used.
(Reference : OPERATION MANUAL P.31 )

NOTE

Tuner settings are saved when you terminate audio interface mode and can be used again the next time by choosing [CONTINUE] when you relaunch audio interface mode.
Effects in audio interface mode

The R16’s insert and send return effects can both be used when the sampling wavelength is set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

**Insert effect**

As in recorder mode, select the insert location and the insert effect algorithm, as well as the effect patches to be applied to the recording signal.

**Send return effect (reverb)**

When in audio interface mode reverb can only be used for monitoring. As in recorder mode, you can use the [SEND RETURN EFFECT] menu to change the patch and the [PAN/EQ] menu to set the send level that adjusts the depth of the reverb signal.

---

**NOTE**

- Effects can only be used when the sampling rate is 44.1 kHz. At all other times it is turned OFF.
- Insert and send return effect settings are saved when you terminate audio interface mode and can be used again the next time by choosing [CONTINUE] when you relaunch audio interface mode.
Working with patches

After you have made many edits, you might want to restore pre-edited settings by initializing the patch. This will return it to its factory preset condition.

**Patch operations**
For both insert and send return effects

**Patch operation menus**

**Select an insert effect or send return effect patch**
Press either INSERT EFFECT or SEND RETURN EFFECT and select a patch from an algorithm.
(Reference: OPERATION MANUAL P.48)

**Patch editing and renaming (EDIT)**
By adjusting the effect module parameters you can set it to create the desired result. You can also change the name.
(Reference: OPERATION MANUAL P.53)

**Importing patches (IMPORT)**
All algorithms (as well as reverb patches) from the effects of the project selected on the R16 can be imported and saved as a single patch.
(Reference: OPERATION MANUAL P.54)
*In the audio interface mode, one complete set of effect data is saved for the mode. There are no project based settings.*

**Saving patches (SAVE)**
Adjusted patches can be saved.
(Reference: OPERATION MANUAL P. 53)

**Initializing patches (INITIAL)**
Restores patches to their original factory settings (only available in audio interface mode).

**HINT**
Even if you have not imported patches the initial settings of patches that were used in the recorder mode can be used.

1. **Patch initialization (factory reset)**
   EFFECT> select patch> PATCH INITIAL

2. **Select algorithm/patch.**
   ![Change menu]

3. **Select**
   ![Change menu]

4. **Select**
   ![Change menu]

5. **Confirm.**
   ![Press [ENTER].]

![Press [ENTER].]
**Cubase LE Startup Guide**

1. Install Cubase LE referring to the bundled 'Download access code sheet'.

2. Download the latest driver from ZOOM website (www.zoom.co.jp) and install it.

3. Connect the ZOOM unit to the computer. Please refer to Operation Manual how to connect.

Start up Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio system" in the Devices Column. Select the downloaded driver or the devices including the ZOOM model names here, e.g. H Series Multi Track is shown as following.

4. Select "VST Connections" from "Devices" menu and set the input and output device ports to the downloaded driver or the devices including the ZOOM model names. For multi-track supported models, click "Add Bus" and add the input bus. e.g. H Series Multi Track is shown as following.

5. Select "New Project" from the "File" menu.

6. "Project Assistant" window opens in order to select a project template. Click "More", select "Empty", and then click the "Create" button to display the project window.

7. Select "Add Track"->"Audio" from "Project" menu and add new audio track.

8. Click "Record" button on the Transport panel and start recording.

Recording starts. Click "Stop" button to stop recording.

9. Click "Play" button to check the recording.

This is all for the basic setting. For more information, please refer to the Documentation from "Help" in Cubase LE or visit Steinberg website (www.steinberg.net/en/home).

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.

©2014 ZOOM CORPORATION Z2I-2186-02